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Title Analysis of the Fuji Japanese Restaurant sales
Students Miss Yupharat Kaeomit Student ID 57050114
Degree Bachelor of Science (Applied Mathematics)
Department Mathematics

Academic Year 2017

Advisor Asst.Prof.Dr.Kanchana Kumnungkit
Job Superviser Miss Peangsakul Wongpradid
Abstract

At present Fuji Japanese Restaurant is regarded as the top Japanese restaurant
in Thailand. So that this restaurant can occupy the market and can grow continuously
every year, the company needs to be targeted, and always plan its marketing. The
study and analysis of sales of restaurant have used as a business decision information.
We used the “PivotTable” as a tool to analyze the data. Based on sales analysis, it’s
common to note that sales between holidays weekends and weekdays are different.
This is because each branch of the restaurant has a different location. The customer
groups using the service are varies. The data énalysis can be useful to enhance

marketing planning, and sales forecasts to be more effective.
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(®) Select a table or range

(O Use an external data source

NS T e v®
‘Choose Cann. ;
68 TSP s 3 el U h

Connection name:
Use this workbook's Data Mode!

Choose where you want the PivotTable report to be placed
(® New Worksheet
O Existing Worksheet

Location: nesem 7_7 :__t_]

Choose whether you want to analyze multiple tables
[[] Add this data to the Data Model

a

JUT 2. 6 #29819015 Create PivotTable

0N



- ludu Choose where you want the PivotTable report to be placed l¥iden
New Worksheet #3® Existing Worksheet #1%5u Existing Worksheet 9 #o 130N
Worksheet ua cell fifiosnn5274 PivotTable

- ddeanisldvatemsaienatsunasdeyalu PovotTable lindnndoana

Lﬂ%‘aqwma Add this data to the Data Model

- AAN OK Ua7 Excel 9374 PivotTable wan uazuanisienis PivotTable Fields

luiuil Field Name miuuu Iiidenndesnindomnsvesundeyaiidesnisiu

: EAE e e T 2 o X e
aslu PivotTable mur1isusiu wadeyaiililidiavesgnifuasluiiuil Row wndayatuil

- & 4 v o d o - & o

waziiarszgniiuasluiiui Column wazivndeyaiiluimiavasgniiuadluiuil Values

Fo o v v v " 1% <4
uenMNigsEIsaaInuazIesensinienldnuatluindeya PivotTable feonules ude
flifisanssenslu PivotTable Snsiely Waneenmnemsiundoyaviesnidnnsiden

o w Y A = a 4 f Ao 9 v | a
nMsBgsdduMensiuadeyafonislufiiaeives PivotTable fivinliiirasonisidsuudaa

anwaLL1ITIALSL

PivotTable Fields '@ S .
Choose fields to add to report: ; o2 ',
'Search o }/ S \{ 75 Sl
MONTH o
CATEGORY {
V] AMOUNT v
Drag fields between areas below:

Y Filters 11 Columns

MONTH -

= Rows ¥ Values

CATEGORY v | | Sumof AMOUNT ~
| Defer Layout Update

g‘uﬁ 2.7 579013 PivotTable Fields



fin PivotTable muA3uY PivotTable Fields ﬁgm’lﬂﬂuﬁuﬁ Values 9zulan
Wy SUM d1 Excel finnudeyadudeninu deyaszgnuanaiu COUNT dhoanmndrdnyil
sesnsavaeulinileilinssmelindoyadmivundeyar uasdiansandsunseuan
Adusuldlaenseaniignasmaiurivesiendayausn udaidendiden Value Field

Settings

NT
RY

Entertainment

Gr
Household
Transportation

nd Total

UM 2. 8 Luntayaiidenmdesiulu PivotTable

Move to Report Filter

m -4

Move to Row Labels

ll  Move to Column Labg!s

Remove Field

i@ Value Field Settings...

X

|

Eﬂﬁ 2. 9 fiden Value Field Settings
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daly Wiudsunisfwanludiu Summarize Values By 1Usansauin ilowdeu

Wn15AwIn Excel avwuanludiu Custom Name Tnednlusd® 19y “Sum of FieldName”

uAdnsaduudasld dadindu Number Format favannsanasusuuuuiaudiniy

\wadayanivun

Value Field Settings

Source Name: AMOUNT

Summarize Values By

Count
Average
Max
Min
Product

Custom Name:  Sum of AMOUNT

Show Values As

Summarize value field by
Choose the type of calculation that you want to use to summarize
data from the selected field

oK

g'u'?i 2. 10 mswAsumsAwId Value Field Settings

featanilsmazuansliiunisliuselevdves PivotTable fie nsuansdndy wnuii

wlinsfwaieasudoyn wiannsauanatuosidudvenndoyald luedhadelud

Iiwasuswumlddrentelutuieuanadu % of Grand Total WuUNASILYBIA

d a ' v . . 9
waziilaiUandaslinau Value Field Setting @11150vn151@enanusiu Show Values As

Entertainment

Grocery
Household
Transportation

ira

3Ui 2. 11 PivotTable gunuuinamaidiu 9%
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Value Field Settings ? X

Source Name: AMOUNT
Custom Name: Sur!gfv AMOUNT

—

Summarize Values By : Show Values As

Show values as
v% of Grand Total 3

Base field: Base item

MONTH i ,’

AMOUNT

|- . R C',',',“_ -

3Ui 2. 12 madadn PivotTable sUwvunnanudu %

fniinmsiiudeyalmiasluuvasioya PivotTable 9zdoanisinsumn PivotTable 7i

ai1efuvuuvaseyaiy WedeanisSinsuifivanils PivotTable aw1sn adnyan Alafld

Tu%a4 PivotTable wdiden Refresh

Analyze

%
i el 2"
i
Refresh Change Data  Clear Sel
e  Source~ - v
[2;- Refresh <

'gﬂﬁ 2. 13 N1 Refresh PivotTable
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waitilnane PivotTable noudu Iidenwadly PivotTable 990ty vy Ribbon 1%luii
1A38sila PivotTable Tools > Analyze > Data >A@n Qnﬂ'i'*?iae‘jma'[ﬁﬂu Refresh wa?
\don Refresh All

d@un13au PivotTable a1u1savilalaeideanya9 PivotTable viavius waing Delete

-

Beaghitiualag fduteyadunie PivotTable niaunugilseuq i PivotTable aglunsiusu

= 4 aad g o

' v ra v o v v ' 7 °
LLUfW]'N‘Mqnﬂiuu‘ua%aau’ﬂmaﬂﬂ'ﬁLﬁUl’) NITAULNUITUUY ﬂ@?ﬁﬂi']ﬂli')'flﬁﬂluﬂ'ﬁu’]

PivotTable @9an

2.1.5 PivotChart

| [ 1

Weildeyaiundilildasy straudusogimiduacosns Tuneuusniifesirde

#5149 PivotTable WeagUuasiianeitayaluguuuuiifiaseain fesanunsavhanled uigld
acdaa o

vnsannsagidiavkazsufeiudiiaduldedssinga PivotChart 1uisnadey

lumsiiunsuansdeyaidunmlitudays

4 s
1 MONTH  CATEGORY AMOUNT
2__‘ : Transportation $74.00
3 |January  Grocery $235.00
4 January  Household $175.00
5 llanuary Entertainment $100.00
6 February Transportation  $115.00
7 |February Grocery $240.00
8 |February Household £$225.00
9 |February Entertainment $125.00
10 \March  Transportation ~ $90.00
11 March Grocery $260.00
12 |March  Household $200.00
12 |March Entertainment $120.00

U7 2. 14 Jeyarlddneneludnu

v
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Household Expenses by Month
$300
$250
$200
$150
| S100
- 1Rk HRAE N

S0

January February March

m Entertainment @ Grocery ® Household & Transportation

3Ui 2. 15 PivotChart dayarldaemelutu

N3a314 PivotTable uag PivotChart wieuiu annsavilddadl
% o as v < 4
- Wonwadlanldnieludeyadinavesnm u&lUR Insert > Pivot Chart >
PivotChart

Create PivotChart ? X

Choose the data that you want to analyze
(@) Select a table or s N o 2 TRt S

(O Use an external data source
nLC!\otse Connection,.. |

Connection name:
Use this workbook's Data Model

Choose where you want the PivotChart to be placed
(® New Worksheet
O Existing Worksheet
TR ]
Choose whether you want to analyze muitiple tables
[[] Add this data to the Data Model

] LT |

gﬂﬁ 2. 16 MIAIAINT5E3149 PivotChart

wnasiidulens

ol = s L g e e (@[] 919 |AS
liannsallag Mdu dnvisuiiiinauladiiley
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- Excel azuanenaoslsinouiinusiumisiiosnisnns Pivotchart Tnewaluudaiiy
AwARTRfiazidendaidan New Worksheet wieltaninsonnassadraunugdliddnuwaey
mufidesnisiaglidswaiudsduuuiingn

- A OK ud Excel azifini3sndnlumidill PivotTable was PivotChart 1w 9ant
PivotChart 1a19zUsIngiuuazuans PivotChart Fields ielianunsoiiiuviodaides
wateyalu PivotChart 16

- lu Field List Widenwadeyadisosnistiuanslu PivotChart

- 9nifu awnsedaguwuy PivotChart 16

Choose fields to add to report: -

[] Order Date
[ ] OrderlD

MORE TABLES...

Drag fields between areas below:

Y FILTERS 1l COLUMNS

|

ROWS | ¥ VALUES
| Salesperson v | || Sum of Order ... v |

__| Defer Layout Update UPDATE

3UT 2. 17 Field List ¥4 PivotChart

hansiluenansianulidmsunisidauienisnwivinuu ldeygslatiluldusslemisunise

Linsdilas Nsdu Snnwinudilvidaudadlioniiazfesdadafadvasenaisnnasaninisunlule
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2.1.6 Warigu HLOOKUP

nsAumArluleIuuYe I visAumendisduesr uddnduarieglunedu
weafuanuadfiszylunsisieluensisd WdWedu HLOOKUP lunsdlfifuuiouiiovey
luumuugavensideya uavdesnisfumanuuasarsnusuuniiisey Tildieidy
VLOOKUP uvu HLOOKUP Lﬁamm‘%’amﬁawaqqmﬁcﬁwLw«ﬁqaq’luﬂaa"uﬁmw'fwuaﬁa:&aﬂ

AsnsAum Snws H luileridu HLOOKUP teanan "Horizontal”

HLOOKUP(lookup_value, table_array, row_index_num, [range_lookup])

guﬁ 2. 18 lhensalvasiandy HLOOKUP

hagnnsaivesitaridu HLOOKUP fonsfawusisei)

- Lookup_value (fp352) AfaswuluunININYINIII Lookup_value 81a9z1du
ANNI919D1 Wioansadoanuile

- Table_array (fo352y) msnedoyaiveyagnium linnséradalugadag wiede
YDIYN

- ArluuaIusnNYe table array @unsaiudanitu faiay viermsIny
" range_lookup u TRUE Arluuaiusnves table array sfouosdrduainios
lUmun Wi .2, -1, 0, 1, 2,.., A-Z, FALSE, TRUE fiaztfu HLOOKUPo199¥ sl

1 v

Ffignees &1 range_lookup 1Uu FALSE laisndudiesdnissdrdiu table array
- TaAuRUUMIRLRIG uazfRUWEnaEE A Ay
- GeadduAndeslumunn wazandrgluam
- Row_index_num (fieeszy) wngiavuaalu table_array Sarrinsefuszgnasndu
row_index_num 83 1 dzdnauuniusnly table array Al row_index_num 89 2
anduAweaumiasslu table_array wazifuuilideslu &1 row_index_num 1egni1 1
Haridu HLOOKUP agdsndu #VALUE! tlufmuanaia &1 row index_num 11nnd

[

FWNUVBIUMIUY table_array Haridu HLOOKUP 9zdindu #REF! 1uAanuiianain

= ' v

- Range_lookup (seyn3elifls) Amssneiiseuitamdanasly HLOOKUP Aumn

‘oA Y a a4 A o 1 | % ' L | o
ﬂqﬁﬂi\jﬂuwaﬂﬂiaﬂqﬂmﬁ\iﬂUIﬂﬂlj'izll"lfu ﬂ']l.ﬁUﬂ'] TRUE W%‘agnaﬂ‘lﬂ WEAINAUAINAITINY

lnguszanm viedndonils dlinudriinseiuned Agegadaluiitfosndn lookup_value

Al
a v

' v v v v o ' 1 a )
ﬂzf‘]‘ﬂa\?ﬂa‘U ﬂ']L{ju FALSE ua? HLOOKUP 2¢AURINISASINUNDA ﬂ"llllWUﬂ']VmsQﬂuwaa

AN MEANAIR #N/A vgnanay

LNANS I 1l FIUL il e b lulaUsglaain

nnsalla: 99773 Uasilloy 19409LA1veeNATNAASINTNSY
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wan adugnlu | adninden
4 4 9
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6 8 11

P 95 - v ¢ % o o
AN 2. 2 qmi ﬂ']aﬁU'lfJLlazwﬂaWﬁﬂq{L‘UﬁQﬂ'ﬁu HLOOKUP ¥94#11579% 2.1
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=HLOOKUP("wwa", A1:C4, | Aum "wa1" Tuwaadi 1 uavdeanduennnua i 2l 4
2, TRUE) Feegluneduniiiatiu (redud A)
=HLOOKUP("ndugnlu’, | Aum "ndugnlu’ luumil 1 wazdendusonuan | 7
A1:C4, 3, FALSE) 7l 3 Jaagluredutiiiatu (edin] B)
=HLOOKUP("B", A1:C4, 3, | #um1 "B" luumii 1 wazdsnduAainuand 3 aq 5
TRUE) aglunedudiieadiu esanlinudrfinsetuiy

8" ﬁ’aﬁuas’tﬁﬁqmnﬁqm’luun'zﬁ 1 feenin 'B"

Fafidie "wan" Ty edud A
=HLOOKUP("adninde1”, | Aum "adninded’ Tuwaadl 1 uasdsnduananuas | 11
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leennmy "¢ luumil 2 uavegluneduiidead
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Liability

gns 9199404 nsdInau
=C2 wad C2 Alluaa C2
=AL:F4 waa Al i F4 Arluigadianun uddasng
Ctrl+Shift+
Enter niamnfinasiisnignaasly
=Asset-Liability |19adfifide Asset was|aluwadiiiae Liability gnaveen

caad

PMnAUwaaNITe Asset
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Week2
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2.1.8 Wendgu IF

ety IF Jadundaluieddumanssne iedsndunidimdrdeulady 93¢ uay
nAmisddeuludu wia

IF(logical_test, value_if _true, [value_if false])

sU 2. 20 hensaivesitaidu IF

- logical_test (§8u) (ouluiidiosnsvaaey

- value_if_true (ful) enfisoemslifdsndudimadnsues logical test 1Wu TRUE

- value_if_false (@v3olifllé) driidoamsliidsndudimadniues logical test 1fu
FALSE

£ | =IFC2="14"1,2)

5Ui 2. 21 daegrmstditeddu IF()

Tugui 2.21 degremslifledidu IFQ) szasreasudouladn 1 Cell “c2” fidnde

Ui Wdenduradnsidu “17 waolilelvdendunaduéidy «27

£ =:F:;c2=:"[‘v"""‘lai'tﬁ")

C B el
1oy Woulvlng

-

SUT 2. 22 dregnanaslditerdidu IF2)

= @ ' v ¢ o - s oA
Tugud 2.22 fregranisldfladidu IF2) azasreaeuidouladn d1 Cell “c2” finde

“1” Iodsndunadwsidu “lo” widlilelvdendunadundidu “lafley”
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2.1.9 Sparkline
: a & o ¢ a P v v P
Sparkline Wuusugfvwadniindilusedifofeuansuuilidoyanin lasil

annsaiuwazInguLuuuNunil Sparkline Tuunuauldsgnsnga
N15a313 Sparkline awnsavilénail
- v o v v :
- dendeyatifieanslviuans Sparkline
. _— | ! v <
- den Quick Analysis fiyuarnvesdeyaiiiden

100

e

E Quick Analysis (Ctrl+Q) i
-~ Use the Quick Analysis tool to
quickly and easily analyze your data
with some of Excel's most useful
. tools, such as charts, color-coding,
| and formulas.

e e

B W A & Y

< v ' 7 L0 ' o
3UN 2. 23 wvEn Quick Analysis MiyuasvIvesteyadidien

- \den SparkLines udiden Line, Column, %30 Win/Loss

Formatting  Charts  Totals  Tables = Sparklines

I!'!l 'll d
Column Win/Loss

Sparklines are mini charts placed in single cells,

gﬂﬁ 2. 24 JUuUV SparkLines

wnanstidulenansianulidmsunsldnuiionsinuiminiu ldeugneliilulduselevisunis

Biansailag Msdu dnnainadilvdaudadlionmiazfesnadefiaudivesenalsunasaninisualuly
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2.2 ARfuavAfia (Arithmetic Mean , Average)
Anadeiavadin (X ) Jainduaiilanuddgunnluinadn szaedsavadn
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2.3 mslnsvidaya

n133AsIERvaya (Data Analysis) Juidlu Business Intelligence ag1ewita daly
manivesnslidoyasneg aniisneg usniessisaudu WieUFuusagsie wienismans
wazfiedimsiasgiveyaidy Business Analytics a81amila Tag Business Analytics 1y

a i v v oy v o a ¢ v a o a a
Bnsiliteyamaluladimensauna Wanhnsinssiteys dedilumsiidugsia

2.3.1 Business Analytics
Business Analytics anunsauuady 3 wuufe
2.3.1.1 milwswideyauuuitugn(Descriptive Analytics) Wuguuuumslitaya
J’ A:' a ' 0w a -: <~ a : a L=
wuuiuguiige lngiiuniseluieinmaniniu vies1avsiineslstu amisassuieii
auvgnsiineie e vinlu @ Descriptive Analytics MBYI1NADTIBIUGIAY SIBUMY
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a ¢ 3 st L vy P
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o v & & “ o . Sl 0w a o v
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efn wfulumansadamnseaneg wiesaufun1svi Data Mining uanani Predictive
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Prescriptive Analytics duvzaunsaviuildsuldmudeyaiiiisduiduiuiniu was

Prescriptive Analytics duunislideyafininiign uasifsaudy Big Data Wuathaun
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